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Newcastle Disease Vaccination using 
Mucoadhesive and Conventional Oral Delivery 
in Commercial Broilers: Serological, Heterophil: 
Lymphocyte ratio and Lymphoid 
Histopathological Changes 

ABSTRACT 

Newcastle Disease (ND) threatens poultry productivity worldwide. Vaccination remains central 
to control, but conventional oral delivery often yields short-lived immunity. Mucoadhesive 
systems are an alternative delivery method that improves mucosal antigen retention and 
immunogenicity. This study compared the serological, physiological, and immunoarchitectural 
responses of broiler chickens administered oral vaccination against ND with local or imported 
LaSota strains delivered either in water or via cashew gum-alginate microbeads. One hundred 
and five broiler chicks were assigned to six groups: unvaccinated controls, blank microbeads, 
imported LaSota in water (ILW) or microbeads (IML), and local LaSota in water (LLW) or 
microbeads (LML). Immune responses were assessed using hemagglutination inhibition (HI) 
assay, heterophil-to-lymphocyte (H:L) ratio, and histopathology of lymphoid tissues. The 
mucoadhesive local LaSota group (LML) produced the highest and most durable antibody titres 
(GMT ≥ 203.2, 14 and 35 days post-vaccination), significantly outperforming all others (P < .05). 
LLW peaked earlier but decayed rapidly, while imported vaccines (ILW, IML) showed weak 
responses. Histopathology revealed strong germinal centre formation in the spleen and jejunum 
of mucoadhesive groups. H:L ratios were significantly lower in these groups (P < .05), suggesting 
potent immunity without physiological stress. Growth performance was unaffected across 
treatments. Mucoadhesive microbeads enhanced ND vaccine efficacy by sustaining antibody 
production, improving lymphoid organization, and reducing stress. The superior response of the 
local strain emphasizes the importance of antigenic alignment with circulating variants. Results 
provide serological, histological, and welfare evidence for adopting mucoadhesive delivery as a 
practical strategy in ND control, particularly for backyard poultry. 

Keywords: Microbeads, mucoadhesive, newcastle disease, oral vaccines, poultry vaccination, 
serology 

INTRODUCTION 

Poultry production plays a crucial role in Africa’s economy, contributing largely to income 
generation, food security, and nutrition.1 The sector is experiencing exponential growth 
globally, with predictions that by 2050, the demand for poultry meat and eggs will increase by 
121% and 65%, respectively.1 However, the economic profitability of poultry production is 
reduced by diseases that adversely affect flock health, negatively impacting animal welfare 
and productivity.2 Newcastle disease (ND) is caused by virulent strains of Avian 
orthoavulavirus 1 (Newcastle disease virus; NDV), a member of the genus Orthoavulavirus 
within the family Paramyxoviridae. It is a highly contagious viral disease that poses a significant 
global threat to poultry farming.3–6 It is characterized by a range of clinical manifestations, 
including respiratory distress, neurological signs, and gastrointestinal symptoms.7 Velogenic 
strains, the most virulent pathotypes, can cause severe outbreaks and up to 100% morbidity 
and mortality in unvaccinated birds.8,9 NDV is transmitted through direct contact with infected 
birds and indirect contact with contaminated fomites.10 
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Newcastle Disease (ND) causes major losses in poultry 
through both high mortalities and reduced egg production, 
which impacts both household incomes and national 
economies.11 Both large-scale commercial farms and 
smallholder backyard poultry producers experience major 
financial setbacks during ND outbreaks, due to the loss of 
birds, lower productivity, and costs of control efforts.12,13 In 
intensive poultry systems, where birds are kept in close 
quarters and in high population, ND spreads rapidly, leading 
to higher mortality, reduced egg production, and increased 
spending on control measures.7,11 The impact of ND goes 
beyond individual farmers, often affecting entire 
communities and families that depend on poultry for 
income and as a key source of food, which raises serious 
concerns for food security and rural livelihoods.11 

ND remains enzootic in many developing countries, 
particularly in Africa.14,15 In Nigeria, outbreaks are common 
across both commercial and backyard poultry 
systems.10,16,17 Several factors contribute to the continued 
spread, including low vaccination coverage, weak 
biosecurity practices, and the circulation of highly virulent 
strains different from the commercial vaccines available.10 
In addition, many farmers lack access to proper vaccination 
methods, and the high cost of quality vaccines often leads 
to the use of cheaper, less effective options.18–20 As there is 
no direct treatment or therapeutic option for Newcastle 
Disease, prevention depends heavily on effective 
vaccination programs coupled with strong biosecurity 
measures.12 Vaccination has been used since the 1950s to 
provide immunity against clinical disease and mortality.6 
This approach is vital in enzootic regions like Nigeria.19 
Common vaccine types used include live attenuated (e.g., 
LaSota, Clone 30, I2, Komarov), inactivated (e.g., Newcavac), 
and recombinant (e.g., HVT/F).6,21,22 

To overcome challenges with cold storage, thermostable 
vaccines such as NDV4-HR and ND I2 have been 
developed.23 However, the success of vaccination largely 
depends on the delivery method used. Many farmers 
struggle with the training and resources needed for 
conventional vaccination methods, which results in irregular 
and often ineffective vaccination.24 These traditional 
methods can also cause discomfort to the birds, potentially 
lowering their feed intake and growth rates.25 Additionally, 
vaccines given through drinking water depend on birds 
consuming the right amount, which can be affected by 
water availability and flock behaviour.26 This emphasizes the 
importance of developing more dependable and efficient 
vaccine delivery methods to ensure the best immune 
response in poultry. 

Traditional oral poultry vaccines have several drawbacks, 
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including limited ability to stay on mucosal surfaces, 
inconsistent immune responses, and breakdown of the 
vaccine in the digestive system.27 A promising alternative is 
mucoadhesive oral vaccine delivery systems, which use 
natural plant-based gums, like those from Khaya 
senegalensis, Boswellia carteri, Cedrela odorata, and 
Anacardium occidentale, that stick to the gut mucosa 
lining.27–29 These delivery systems help vaccines release 
slowly and absorb better by staying longer on the mucosal 
surfaces, and they also reduce stress on the birds since they 
avoid the need for injections.27–29 They also offer a non-
invasive, easier-to-administer alternative to injections and 
conventional oral methods, potentially improving vaccine 
retention and immune response.25,27–29 While 
mucoadhesive systems show promise, a direct comparison 
of their impact on serological, stress, and lymphoid 
histological outcomes against conventional delivery, 
especially with local vs. imported vaccine strains, is lacking. 
To enhance ND control strategies, especially in resource-
limited settings, emphasis should be on the use of 
mucoadhesive systems to offer a potential alternative by 
simplifying administration, improving efficacy, and 
potentially enhancing formulation stability under field 
conditions, as reported for mucoadhesive delivery 
systems.29 We hypothesized that mucoadhesive delivery of 
a locally produced LaSota vaccine would induce stronger, 
more sustained antibody titres, reduced physiological 
stress, and enhanced lymphoid activation compared to 
conventional delivery or imported strains. This study, 
therefore, evaluates the serological efficacy, specifically HI 
antibody responses, induced by mucoadhesive and 
conventional oral delivery systems for ND vaccination in 
commercial broiler chickens. 

MATERIALS AND METHODS 

Experimental Chickens 
One hundred and five-day-old Ross 308 broiler chicks 
purchased from a local hatchery were used for this 
experiment. The chicks were randomly divided into six 
groups of 17 chicks per group, namely: UV (unvaccinated 
control), BMB (blank microbead), ILW (imported LaSota in 
water), IML (imported LaSota in microbeads), LLW (locally-
produced LaSota in water), and LML (locally-produced 
LaSota in microbeads). The chicks were raised in poultry 
pens at the Teaching and Research Farm, University of 
Ibadan, from day old until the day of termination of the 
experiment. All chicks were given feed and water ad libitum. 
The study was conducted in accordance with the provisions 
and procedures set out by the University of Ibadan Care 
Animal Care and Use Research Ethics Committee (UI-
ACUREC/082-0524/24) with assigned number and 
(18.07.2024). 
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Preparation and Purification of The Raw Cashew Gum 
The preparation of purified cashew gum followed the 
method previously described by Ola et al.29. In brief, raw 
gum was manually cleaned, dried, milled, and subjected to 
aqueous extraction and ethanol precipitation. The resulting 
precipitate was washed, dried, and sieved to obtain the final 
purified gum. 

Formulation of Microbeads 
Microbeads were formulated using the ionotropic gelation 
technique as previously described by Ola et al.29. Briefly, 
aqueous dispersions of sodium alginate and cashew gum 
were combined and extruded into an aluminium sulphate 
solution to form and cross-link the beads, which were then 
washed, freeze-dried, and stored for use. 

Vaccine Incorporation into Microbeads 
Vaccine-loaded microbeads were prepared as previously 
described by Ola et al.29. Briefly, reconstituted vaccines 
were incorporated into the polymer blend, mixed 
thoroughly, and processed using the same extrusion and 
drying protocol as for the blank microbeads. 

Vaccine and Vaccination 
All experimental birds in this study were vaccinated at 14 
days old. Newcastle Disease Provac LaSota vaccine (a 
commercially available imported vaccine), and NVRI LaSota 
vaccine (a locally produced vaccine from National 
Veterinary Research Institute, Vom, Plateau State Nigeria), 
were used. Groups IML and ILW were vaccinated using the 
imported LaSota vaccine in mucoadhesive and conventional 
delivery respectively, and LML and LLW were vaccinated 
using the NVRI LaSota vaccine in mucoadhesive and 
conventional delivery respectively. Group UV was 
unvaccinated, as well as BMB which received blank 
microbeads. 

Collection of Blood Samples and Sera 
Blood samples were collected at day 0 and weekly from days 
14 to day 49 post-hatch following vaccination on day 14. The 
birds were brooded from day 0 to 14 with standard feed and 
water provided ad libitum. The experiment concluded on 
day 49. The samples were collected from the wing veins of 
five selected chickens using a sterile syringe and 23G 
needle, into plain and heparinized tubes. These plain tubes 
were left undisturbed at room temperature for 30 minutes 
to allow blood clot formation, after which they were 
transported to the laboratory in an ice packed Styrofoam 
box and subsequently centrifuged at 3000 rpm for 5 
minutes to separate the serum. After collection, the serum 
was gently transferred using a micropipette and stored at –
20°C until further tests could be done. Standard 
haematological parameters were measured such as packed 
cell volume (PCV), haemoglobin concentration (Hb), red 

blood cell count (RBC), white blood cell count (WBC), and 
leukocyte differentials. The heterophil-to-lymphocyte (H: L) 
ratio was calculated by dividing the number of heterophils 
by the number of lymphocytes in each heparinized blood 
sample. 

Serological Analysis 
The sera collected from the experimental chickens were 
tested for Newcastle Disease antibodies using the 
Haemagglutination Assay/Haemagglutination Inhibition 
(HA/HI) test, following the method described by Allan and 
Gough.30 The HA titres of the ND antigen were measured, 
and the sera were diluted to contain 4 HA units for the 
assay. 

Haematology Analysis 
Packed cell volume (PCV) was determined using the 
microhaematocrit method, as previously described by 
Schalm et al.31 where blood in heparinized microcapillary 
tubes was centrifuged at 3000 rpm for 5 min and read with 
a hematocrit reader. Hemoglobin concentration (Hb) was 
measured by the cyanmethaemoglobin colorimetric 
method using Drabkin’s solution and read on a Sahli’s 
hemoglobinometer. Red blood cell (RBC) counts were 
obtained manually with a Neubauer hemocytometer 
following 1:200 dilution with erythrocyte fluid. White blood 
cell (WBC) counts and differentials were determined from 
Giemsa-stained smears, with 200 cells classified into 
heterophils, lymphocytes, eosinophils, basophils, and 
monocytes; absolute values were calculated from 
differentials. Platelet counts were estimated 
microscopically from Giemsa-stained smears by averaging 
counts across multiple fields. 

Heterophil-to-Lymphocyte Ratio 
As per Gross and Siegel32, and corroborated by Lentfer et al.
33, the H:L ratio serves as a validated measure of 
physiological stress in poultry. Blood smears were air-dried, 
Giemsa-stained, and 200 leukocytes per bird were manually 
counted and differentiated in five randomised areas at 100X 
magnification into heterophils and lymphocytes. The H:L 
ratio was calculated by dividing the absolute heterophil 
count by the lymphocyte count. 

Histopathological and Architectural Analysis 
Spleen, jejunum, thymus, and bursa of Fabricius samples 
were collected from all groups at Day 35 Post-Vaccination 
and fixed in 10% neutral-buffered formalin for 24 hours. The 
samples were processed routinely through graded alcohols 
for dehydration, cleared in xylene, and embedded in 
paraffin wax. Paraffin blocks were sectioned at 5 µm 
thickness using microtome, mounted on glass slides, and 
stained with hematoxylin and eosin (H&E). Stained sections 
were examined under a light microscope (Olympus CX21) at 



19 

40 and 100X magnifications, and photomicrographs were 
captured using a DinoEye eyepiece digital camera. 

Digital Quantification of Cellularity (ImageJ Analysis) 
Quantification of area-standardized cell density was 
performed using ImageJ (v.1.53) following established 
methods for histomorphometric analysis.34 From the 
photomicrographs, three representative regions of interest 
(ROIs) of the key lymphoid areas (especially the white pulp 
in the spleen, the crypts in the jejunum, and the cortex in 
the thymus) were selected for analysis. The image scale was 
set in ImageJ to Analyze > Set Scale, using the scale bar from 
the scanned image to convert measurements from pixels to 
micrometers (µm). The perimeter of each selected 
lymphoid follicle was manually outlined using the freehand 
selection tool. The area of each ROI was recorded using 
Analyze > Measure. The image was converted to 8-bit, 
Image > Type > 8-bit. A consistent thresholding algorithm, 
Image > Adjust > Threshold, using Default, was applied to 
differentiate stained cell nuclei from the background. The 
threshold values were kept constant for all samples within 
the same organ. The "Analyze Particles" function was used 
to count particles (cell nuclei) within the threshold area. 
Particle sizes were set between 10 pixels and infinity to filter 
out debris and focus on the nuclei size. The results displayed 
included particle count and average intensity. To 
standardize, the raw cell count for each region of interest 
(ROI) was divided by the area of that ROI, giving a cell 
density measured in cells per square millimeter. For each 
organ and treatment group, the average cell density was 
calculated across all technical (ROIs) and biological 
replicates (groups) and presented as mean ± standard 
deviation. 

Germinal Center Scoring (Germinal Center Index - GCI) 
The immune response’s structural organization was 
evaluated using a semi-quantitative Germinal Center Index 
(GCI). This scoring system, adapted from established 
histological grading methods,35 has been applied in vaccine 
immunology studies.36 The GCI rates the maturity of 
lymphoid follicles on a scale from 0 to 3, reflecting their 
functional development. 

Statistical Analysis 
The data generated were serological antibody titres 
obtained via the Hemagglutination Inhibition (HI) assay. 
Antibody titres were expressed as mean ± standard 
deviation (SD). These analyses were applied specifically to 
the HI titre data sets collected from the six experimental 
groups (UV, BMB, ILW, IML, LLW, and LML) over the weekly 
sampling points. To determine statistically significant 
differences on the haematological data among treatment 
groups at different time points, data were analysed using 
one-way ANOVA, followed by Tukey’s post hoc test. Data 
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were expressed as mean ± standard deviation (SD). A P-
value < .05 was considered statistically significant. All 
analyses were conducted using SPSS version 16 (SPSS Inc., 
Chicago, IL, USA) and GraphPad Prism version 8. 

RESULTS 

As shown in Figure 1, the geometric mean antibody titres 
(GMT) were uniform across all groups (4.0) on the day of 
vaccination (Day 0 post vaccination, 14 days post-hatch). By 
Day 21 (7 days post-vaccination), there were differences in 
the immune responses. Locally produced LaSota vaccines 
(LLW, LML) elicited stronger early responses compared to 
imported vaccines (ILW, IML). For instance, LLW reached a 
GMT of 105.9, approximately 7.6-fold higher than ILW 
(13.9) and >26-fold higher than IML (4.0). LML also 
demonstrated a robust response (74.6), about 5.4-fold 
higher than ILW and nearly 19-fold higher than IML. 

Figure 1. Geometric mean antibody titres (GMTs) of broiler chickens 
following Newcastle Disease vaccination with different delivery 
systems. 

The advantage of mucoadhesive delivery became more 
apparent over time. LML increased progressively to a peak 
of 203.2 on day 14 post-vaccination (14 dpv) and remained 
at this level through day 35. By contrast, LLW peaked at 
GMT of 181.0 (14 dpv) but declined steadily, reaching 45.3 
three weeks after (35 dpv) (a 4-fold drop. Separately, the 
IML reached its highest point of 90.5 at 21 days post-
vaccination (dpv), but then dropped sharply to 11.3 by 35 
dpv, representing an eightfold decrease. ILW, despite a 
modest rise to 25.4 on day 28, regressed rapidly toward 
baseline. Collectively, these findings evidently give the dual 
advantage of (1) antigenic alignment with locally produced 
strains, which achieved higher initial responses, and (2) 
mucoadhesive delivery, which ensured sustained protective 
titres. 

The overall antibody responses, summarized as mean ± SD 
of geometric mean titers (GMT) (Figure 2), showed clear 
group differences. Both unvaccinated (UV) and blank 
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microbead (BMB) groups remained at baseline levels (4.0–
4.17), confirming no vaccine effect. Imported vaccine 
groups (ILW, IML) exhibited lower and more variable 
responses, with mean GMTs of 9.83 ± 8.19 and 25.96 ± 
32.18, respectively. In contrast, locally produced vaccine 
groups (LLW, LML) demonstrated significantly higher 
responses, with LML (127.90 ± 96.80) achieving the most 
robust and sustained antibody production. 

Figure 2. Mean (±SD) geometric mean titres (GMT) of broiler chickens 
vaccinated using different Newcastle Disease vaccine delivery 
systems. Bars represent group means with standard deviation error 
bars. Columns bearing different letters differ significantly (P ≤ .05; 
Tukey’s post hoc test) 

Figure 2 summarizes the overall antibody responses per 
group across the experimental period. The locally produced 
LaSota vaccines demonstrated markedly higher GMTs 
compared to the imported counterparts. The LML group 
achieved the highest mean antibody titre (127.9 ± 96.8), 
followed by LLW (76.9 ± 63.7). In contrast, IML (26.0 ± 32.2) 
and ILW (9.8 ± 8.2) elicited much lower responses, while UV 
and BMB remained at baseline. The wider SD observed in 
the mucoadhesive groups (especially LML) reflects 
biological variability but reinforces the superior 
immunogenicity of local vaccines, particularly when 
delivered via mucoadhesive microbeads. These findings 
corroborate the time-course analysis (Figure 1), further 
emphasizing that combining a locally adapted strain with a 
mucoadhesive system enhances both the magnitude and 
durability of the immune response. 

Weight Gain, Hematology, and Heterophil: Lymphocyte 
Ratio 
Weight gain across all groups was steady with an upward 
trend and no evidence of growth suppression. Birds in the 

mucoadhesive vaccine groups (LML, IML) exhibited slightly 
higher terminal body weights compared to those in 
conventional vaccine groups (LLW, ILW), although 
differences were not statistically significant (P > .05). This 
indicates that oral vaccination, regardless of delivery 
method, did not adversely affect growth, (Figure 3). 

Figure 3. Line graph showing the weekly changes in mean body weight 
(±SD) of broiler chickens across experimental groups following 
Newcastle disease vaccination via different delivery methods 

Haematological parameters (PCV, Hb, RBC) remained within 
physiological ranges across all groups, an indication that 
neither vaccine source nor delivery system induced 
haematological changes. However, vaccinated birds showed 
higher WBC counts compared to controls, attributable to 
vaccine-induced immunological activity. At baseline (Day 0), 
all groups had similar H:L ratios (0.38 ± 0.04). Following 
vaccination, conventional oral vaccine groups (LLW, ILW) 
showed higher H:L ratios at peak response (0.65 ± 0.08), 
whereas mucoadhesive vaccine groups (LML, IML) 
maintained lower and more stable ratios (0.42 ± 0.05), 
indicating lower physiological stress (Figure 4). 

Figure 4. Mean (±SD) heterophil-to-lymphocyte (H:L) ratios of broiler 
chickens across experimental groups. Error bars indicate standard 
deviations. Bars with different letters are significantly different (P ≤ 
.05; Tukey’s post hoc test) 
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Figure 5. Histology of lymphoid tissues in conventional oral NDV-
vaccinated birds. (A) Spleen with preserved architecture (PALs, arrows). 
(B) Jejunum with intact villi (double arrows). (C) Thymus with normal
corticomedullary differentiation (curved arrow). (D) Bursa of Fabricius 
with typical cellularity (stars). No reactive germinal centers observed. H&E
stain; 100× magnification; scale bar = 50 µm

Histopathological Findings 

Histopathologic evaluation of lymphoid tissues showed 

differences between the control, conventional oral vaccine, 

and mucoadhesive oral vaccine groups (Figures 5 and 6). In 

the thymus, mucoadhesive vaccination produced higher 

lymphoid cellularity and mild-to-moderate cortical 

lymphocyte density compared to mild changes in the 

conventional group. The bursa of Fabricius displayed 

hyperplastic follicles and increased plasma cell populations 

in the mucoadhesive group, scoring 2.5 (moderate to 

marked), while conventional vaccination elicited only 

moderate stimulation (score 2.0). In the spleen, 

mucoadhesive vaccination was associated with expansive 

periarteriolar lymphoid sheaths and dense germinal 

centres, scoring 3.0 (marked), compared to moderate 

activity in conventional groups (2.5). Similarly, jejunal MALT 

exhibited organized lymphoid aggregates and hyperplastic 

Peyer’s patches in the mucoadhesive group, in contrast to 

the moderate stimulation observed following conventional 

oral vaccination. 

ImageJ analysis of lymphoid organs revealed distinct 

patterns of cellularity between the two delivery systems 

(Figure 7). While no statistically significant differences in cell 

density were detected between the control and 

conventional vaccine groups in the spleen and jejunum, the 

mucoadhesive vaccine group elicited a profound and 

substantial increase in cell density, characterised by a 
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marked increase in lymphoid cellularity, within the 

lymphoid tissues having direct link with the oral mucosa, 

especially the peyer’s patches in the jejunum and the 

increased lymphocyte density in the bursa of Fabricius. Also, 

the cell count in the thymus was approximately 2.5-fold 

higher in the mucoadhesive group compared to the 

conventional group (P < .01). Similarly, the bursa of Fabricius 

showed a near 2-fold increase in the mucoadhesive group 

(P < .05). This targeted enhancement in the thymus (the site 

of T-cell maturation) and the bursa (the site of B-cell 

maturation) provides a histological basis for the stronger 

and more persistent immune response observed in the 

serological data, indicating that mucoadhesive delivery 

promotes broader activation of the adaptive immune 

system. 

Figure 6. Histology of lymphoid tissues in mucoadhesive oral NDV-
vaccinated birds. (A) Spleen with multiple lymphoid follicles and germinal 
centers (yellow arrows). (B) Jejunum showing organized submucosal 
lymphoid nodules (arrowheads). (C) Thymus and (D) Bursa of Fabricius 
display densely packed lymphocytes (stars), consistent with active 
lymphoid stimulation. H&E stain; 100× magnification; scale bar = 50 µm 

Figure 7. Comparison of Lymphoid Cellularity Between Vaccine Delivery 
Systems. 
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Area-standardized cell counts in various lymphoid organs 
from chickens vaccinated with conventional and 
mucoadhesive orally delivered Newcastle disease vaccine. 
Data is presented as the mean ± standard deviation (n=2 
samples per group per organ) and is intended to provide 
descriptive support for observed histological trends rather 
than infer population-wide statistical significance. Statistical 
significance was determined by an unpaired t-test for each 
organ. Note the significantly higher cell density in the 
Thymus, Bursa of Fabricius, Spleen, and Jejunum of the 
mucoadhesive group, suggesting enhanced systemic and 
humoral lymphoid activation. 

The Germinal Center Index (GCI) is a semi-quantitative 
histological scoring system developed to quantify the 
architectural organization and functional maturity of the 
immune response within secondary lymphoid organs 
following vaccination. While total cell counts (e.g., from 
ImageJ analysis) provide a measure of the magnitude of 
cellular infiltration, they are agnostic to the organization of 
that response. The GCI helps evaluate the immune response 
by specifically scoring the presence and quality of germinal 
centers (GCs). These are specialized sites within lymphoid 
follicles where key adaptive immune processes take place. 
The GCI was scored histologically on a scale from 0 to 3: 0 
means absent, 1 indicates poorly defined, 2 means defined, 
and 3 represents prominent germinal centers. Histological 
analysis showed that the mucoadhesive vaccine not only 
increased overall cellularity but also significantly improved 
the organized structure of the immune response in 
secondary lymphoid organs (Figure 8). 

Figure 8. Germinal Center Index (GCI) in lymphoid organs of chickens 
vaccinated with conventional oral or mucoadhesive-delivered Newcastle 
disease vaccine. 

In the spleen, the mucoadhesive vaccine group displayed 
large, prominent germinal centers (GCI: 2.5 ± 0.7), which is 
a key sign of strong T-cell-dependent B-cell activation and 
affinity maturation. In contrast, the conventional vaccine 

group only showed small, poorly defined lymphocyte 
density (GCI: 1.0 ± 0.0). This architectural superiority 
occurred despite comparable total cell counts between the 
groups (Mucoadhesive: 8.85 ± 5.26 ×10⁶ vs. Conventional: 
7.92 ± 1.02 ×10⁶; P > .05), indicating that the mucoadhesive 
delivery shifted the response from a diffuse infiltration to a 
highly organized and functional state. A similar, though less 
pronounced, trend was observed in the jejunum, where the 
mucoadhesive group showed better-defined lymphoid 
follicles (GCI: 2.0 ± 0.0) compared to the conventional group 
(GCI: 1.0 ± 0.0), alongside a higher cell density (10.85 ± 0.92 
vs. 9.15 ± 0.92 ×10⁶ 

DISCUSSION 

This study demonstrates that mucoadhesive oral delivery of 
ND vaccine using cashew gum-alginate microbeads 
significantly enhances vaccine performance, as evidenced 
by serological responses, H:L ratios, and lymphoid 
histopathology. The primary findings are twofold: (i) local 
LaSota vaccines produced superior immunogenicity relative 
to imported strains, and (ii) mucoadhesive delivery 
sustained both antibody responses and lymphoid activation 
beyond what was achieved by conventional methods. 
Together, these observations validate the hypothesis that 
combining locally adapted vaccines with mucoadhesive 
carriers addresses both antigenic mismatch and delivery 
inefficiencies that have historically limited ND control in 
endemic regions. 

Our findings align with prior reports that vaccine efficacy is 
optimized when strains match circulating field viruses and 
are consistent with emerging global evidence that mucosal 
vaccine delivery can improve immune efficiency against 
Newcastle disease.10,37 The striking underperformance of 
imported LaSota strains, despite their commercial 
availability, likely reflects antigenic divergence from 
Nigerian NDV isolates, as similarly observed where certain 
carriers proved unsuitable.38,39 This underscores the critical 
role of regional vaccine production in enzootic settings.38 
Furthermore, the enhanced antibody kinetics seen with 
mucoadhesive carriers are consistent with previous work on 
phytogenic gums, which demonstrated improved antigen 
uptake and prolonged stimulation of mucosal 
immunity.26,27,29,40 Similar challenges with suboptimal 
seroconversion, stress-associated immunosuppression, and 
lymphoid depletion following conventional oral vaccination 
have been reported in commercial poultry systems across 
sub-Saharan Africa, South and Southeast Asia, and parts of 
Latin America.1,41,42 

Histopathological data complement serological outcomes 
by providing anatomical evidence of vaccine efficacy. 
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Mucoadhesive delivery induced germinal center 
hyperplasia in the spleen, lymphoid nodules in the jejunum, 
and bursal follicle hyperplasia, hallmarks of intensified 
antigen presentation and B-cell activation.43,44 These 
findings are important because they show that the 
increased antibody levels weren’t just temporary or non-
specific; they reflected real structural changes in the 
immune system. In contrast, birds vaccinated using 
conventional methods showed only mild to moderate 
immune responses, while control birds remained mostly 
inactive. This confirms that the stronger lymphoid activation 
was directly caused by the vaccine.44 By promoting 
sustained antigen interaction with mucosal-associated 
lymphoid tissues, mucoadhesive platforms may enhance 
both humoral immunity and immune resilience, outcomes 
that are increasingly recognized as critical for effective ND 
control worldwide. These findings, therefore, extend the 
global literature by linking improved serological 
performance with reduced physiological stress and 
preserved lymphoid architecture, supporting the broader 
applicability of mucoadhesive oral vaccination strategies 
beyond the study setting. Additionally, this study provides 
evidence on the systemic and stress-related blood 
responses from mucoadhesive versus conventional 
Newcastle Disease vaccine delivery. The fact that no 
negative effects were seen on weight gain supports that oral 
vaccination, no matter the method, is safe for growth.41,45 
However, the blood profiles reveal differences in the 
physiological impact of each delivery system. 

The significantly lower heterophil-to-lymphocyte (H:L) 
ratios in the mucoadhesive groups (LML, IML) suggest an 
advantage, providing effective immune stimulation without 
causing stress-related increases in heterophils. This is unlike 
the conventional oral groups (ILW, LLW), where higher H:L 
ratios point to leukocyte shifts linked to systemic stress. 
These results support the established use of the H:L ratio as 
a reliable stress and welfare marker in poultry.32,33  

The histological data as analyzed by ImageJ and summarized 
in Figure 7, move beyond serological correlation to suggest a 
mechanistic cause. The mucoadhesive formulation's 
superior efficacy is not merely a function of prolonged 
antigen release but is fundamentally linked to its ability to 
drive a quantitatively larger response in the primary 
lymphoid organs, effectively seeding a larger pool of 
antigen-specific T and B cells. The lack of a significant 
difference in the jejunum (a mucosal site) versus the 
significant difference in systemic organs (thymus, bursa) is 
particularly intriguing. It suggests that the mucoadhesive 
vaccine's key advantage may lie in its efficiency in 
transporting antigen from the mucosal site to the systemic 

immune system, leading to a more  robust  systemic  humoral 
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response rather than just a local one. The significant 
increase in bursal and thymic cellularity strongly implies 
lymphocyte hyperplasia (an increase in cell number), likely 
due to enhanced antigen-driven activation and 
proliferation. This aligns with the theory of a more effective 
germinal center reaction, leading to the higher antibody 
titers and persistence observed. 

Our findings demonstrate that the benefit of mucoadhesive 
delivery is not merely quantitative but, more importantly, 
qualitative. The formation of prominent germinal centers in 
the mucoadhesive group explains the higher antibody 
affinity and persistence observed serologically. Germinal 
centers are the engines of immunological memory, 
providing a mechanistic histological basis for the sustained 
protection offered by this platform.43,44 The high variance in 
total splenic cell count for the mucoadhesive group is likely 
due to the focal nature of germinal centers. A single section 
may pass through a large GC (high count) or miss it (lower 
count). The GCI score is therefore a more reliable and 
functionally relevant metric for assessing vaccine efficacy in 
the spleen than total cellularity alone. 

Despite these promising outcomes, the study has the 
following limitations: first, immunohistochemistry and 
immunofluorescence assays, which could have directly 
confirmed antigen distribution and lymphocyte subset 
activation, have not been done yet. While the digital 
quantification using ImageJ provided insights into cellular 
density shifts, we acknowledge the small sample size (n=2) 
used for the specific analysis as a limitation. 

The results should be interpreted as preliminary evidence of 
lymphoid hyperplasia. Furthermore, the absence of 
immunohistochemistry to delineate specific lymphocyte 
subsets (CD4+, CD8+) means that observed increases in 
cellularity represent a generalized immune activation. 
Future studies with larger groups and phenotypic markers 
are necessary to confirm the specific kinetics of the cellular 
response driven by mucoadhesive delivery. 

Second, the study was conducted under controlled 
experimental conditions; field evaluation is required to test 
performance in the face of natural NDV exposure, co-
infections, and varying husbandry practices. Finally, the 
delayed onset of immunity observed with mucoadhesive 
vaccines, though ultimately yielding sustained protection, 
could represent a window of vulnerability that may require 
management through vaccination scheduling or booster 
strategies. 

Formation of germinal centres represents the 
morphological hallmark of a secondary immune response in 
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vaccinated flocks. Their presence in mucoadhesive-
vaccinated birds, coupled with sustained antibody titres, 
provides strong tissue-level and serological evidence for the 
biological plausibility of this delivery system. This study 
indicates that both the vaccine strain and the method of 
delivery potentially synergize to influence the magnitude 
and duration of the immune response. Locally sourced 
LaSota strains offer a stronger antigenic match, while 
cashew gum-alginate microbeads support longer-lasting 
immune activation. Overall, the histomorphometric date 
serve as preliminary observations, the robust serological 
findings provide strong support for mucoadhesive delivery 
systems as a promising and welfare-friendly vaccination 
strategy. This approach facilitates sustained antibody 
responses without causing undue physiological stress as 
indicated by the stable H:L rations. As a result, these findings 
position mucoadhesive oral vaccines as a scientifically viable 
strategy for ND control, especially as an adjuvant for 
mucosal vaccine delivery in smallholder systems where 
conventional methods are less feasible. 
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